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Information and Notices

Copyright and Disclaimer

Copyright protection claimed includes all forms and matters of copyrightable material and 
information now allowed by statutory or judicial law or hereinafter granted, including without 
limitation, material generated from the software programs which are displayed on the screen 
such as icons, screen display looks etc.

Information in this manual and software are subject to change without notice and does not 
represent a commitment on the part of SAM. The software described in this manual is 
furnished under a license agreement and can not be reproduced or copied in any manner 
without prior agreement with SAM, or their authorized agents.

Reproduction or disassembly of embedded computer programs or algorithms prohibited.

No part of this publication can be transmitted or reproduced in any form or by any means, 
electronic or mechanical, including photocopy, recording or any information storage and 
retrieval system, without permission being granted, in writing, by the publishers or their 
authorized agents.

SAM operates a policy of continuous improvement and development. SAM reserves the right 
to make changes and improvements to any of the products described in this document 
without prior notice.

Contact Details

Customer Support

For details of our Regional Customer Support Offices please visit the SAM web site and 
navigate to Support/Customer Support Contacts.

https://s-a-m.com/support/contact-support/

Customers with a support contract should call their personalized number, which can be found 
in their contract, and be ready to provide their contract number and details.

http://www.snellgroup.com/support/customer-support/customer-support/
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RollCall Control Panel Introduction
1. Introduction

1.1 Overview

The RollCall Control Panel enables the control of RollCall-compatible units over a network. 

Every RollCall-compatible unit has a template that allows control of the device. Control levels 
can be configured with different access levels (User, Engineer, or Supervisor), allowing only 
access to those functions and settings required by the current user.

The Control Panel is written in Java and requires the Oracle Java Runtime Environment 
(JRE) to be installed. JRE 1.7 or later is required.

The Control Panel can be run either as an applet or as an application.

1.2 Software Setup Information

1.2.1 Enabling ClearType Rendering

When drawing text on the screen, the Control Panel (application or applet) uses the currently 
specified Windows rendering method. For the best appearance, use ClearType rendering.

To enable ClearType rendering on Windows XP:

1. Open the Window properties screen.

2. Select the Appearance tab, and then click on Effects. The Effects screen displays.

3. From the Use the following method to smooth edges of screen fonts drop-down 
list, select ClearType.

To enable Cleartype rendering on Windows 7:

1. From Windows Control Panel, select Display.

2. From the side tab select Adjust ClearType text. The ClearType Text Tuner screen 
displays.

Fig 1. Effects
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3. Check the Turn on Clear Type checkbox.

4. Click Next.

5. On the next screen, select the screen to tune, or all screens accordingly, and click 
Next.

6. Follow the on-screen instructions to setup the clearest text for the screen.

7. Click Finish.

1.3 Running the Control Panel as an Applet

New IQ modular chassis are shipped with a Control Panel applet on board. Details of how to 
launch the applet are given in the IQ modular chassis documentation.

1.3.1 Applet Cross Platform Support

The applet can run on Windows, Mac OS, and Linux operating systems.

Some versions of the operating systems require extra actions before running the applet:

Windows XP and 7

• Enable ClearType Rendering (all Windows versions). See Enabling ClearType 
Rendering on page 5.

Mac OS X

• In Safari 6.1 and above, add the applet website to the White List, and allow it to run in 
Unsafe mode. It is also necessary to turn off the popup blocker.

• Ensure that Java 1.7 or later is used.

When using the Mac OS, the default Aqua look and feel cannot be changed.

Linux

• The Selinux security manager can prevent the applet from running in Firefox.

Fig 2. Effects

Note: Some earlier chassis may have been supplied with a V 1.0.0 Control Panel Applet. 
Documentation for this version was supplied as part of the corresponding IQ modular 
chassis documentation.

Note: When running the applet on either Mac OS or Linux, there is no support for serial network 
connection, or for upgrading 30 Series Modular Converters.
Issue 7 Rev 1 Page 6 ©  2015 SAM
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1.3.2 Optimizing the Applet's Display

There are Java System properties used to improve aspects of the Applet's performance: 

• Xmx - Controls the amount of memory allocated to the applet. A minimum of 512MB 
is recommended 

• sun.awt.noerasebackground - Controls background erasing during resize. Turning 
it off prevents flickering while resizing or scrolling. 

• sun.java2d.noddraw - Controls the use of DirectDraw. In a system where DirectDraw 
is not properly supported by the hardware, use of DirectDraw can cause screen 
corruption when scrolling. 

To set the Java System properties:

1. Open the Java Control Panel and select the Java tab.

2. Click the View button in the Applet Runtime Settings panel.

3. Copy and paste the line below into Java Runtime Parameters:

-Xmx512m -Dsun.awt.noerasebackground=true 
-Dsun.java2d.noddraw=true

1.3.3 Applet Parameters

To launch the applet directly, without navigating to the chassis's home page, type the 
following into the address bar of a browser:

IP address/ram/applet.htm

Where IP address is the address of the IQ modular chassis.

Use this, in conjunction with query string parameters, to modify the behavior of the applet. 
The applet recognizes the following query string parameters:

Examples:

IP address/ram/applet.htm?port=2060 to use a different port number

IP address/ram/applet.htm?width=800&height=600 set the initial width and height 

1.3.4 Default Home Directory

The home directory contains many of the files required or created by the Control Panel - for 
example, log files, savesets, and the menu and template caches.

The default home directories according to each operating system are:

Parameter Description

Gateway The IP address to connect to (it defaults to the chassis the applet is 
loaded from).

Port The IP port address to use (it defaults to port 2050).

Width The width of the applet window (the default depends upon the screen 
resolution).

Height The height of the applet window (the default depends upon the screen 
resolution).

Unit The RollCall address of a unit to auto-connect on startup.
Table 1. Applet Parameters

Windows 7 C:\ProgramData\SAM\controlpanel

Windows XP C:\Documents and Settings\All Users\SAM\controlpanel
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1.3.4.1 Change the Default Home Directory

On Windows, the default home directory is common to all users. However, some 
organization’s IT policies may restrict access to this directory. In which case, an alternative 
home directory can be specified using the CONTROLPANEL_HOME environment variable:

1. Ensure that the RollCall Control Panel is not running.

2. Click the Windows Start menu and select Control Panel.

3. From the Control Panel window, open the System properties.

4. Click Change Settings (Windows 7 only).

5. Click the Advanced tab, and then click on Environment Variables.

6. In the System variables section, click New.

7. In the dialog that displays, enter CONTROLPANEL_HOME in the Variable name field. 
Then, in the Variable value field, enter the location in which you would like the home 
directory to be created, for example, C:\rollcallhome.

8. Click OK to close the New System Variable dialog, then click OK to close the 
Environment Variables and System Properties dialogs.

Mac OS  [1] Users/<user.home>/Library/Application Support/SAM/controlpanel

Linux [1] <user.home>/SAM/controlpanel

[1] Where <user.home> is the name of a MAC or Linux user account

Fig 3. Environment Variables

Fig 4. New System Variable
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1.4 Running the Control Panel as an Application

The Control Panel is also supplied as part of the RollCall Infrastructure Management System 
(version 4 and above).

1.4.1 Memory

The Control Panel uses a default memory allocation of 512MB. 

This can be changed, if necessary, by doing the following:

1. Close Control Panel if it is running.

2. Create an empty text file called 'RollCall Control Panel.vmoptions' in the directory 
where Control Panel is installed (on Windows 7 this will require admin privilege).

The default home directory where the Control Panel is installed differs according to 
the operating system being used. See Default Home Directory on page 7.

3. Copy the following into the file:

-Xmx512M

This allocates 512MB of memory. Replace “512” with the amount of memory required 
for allocation.

4. Save the file.

5. Now, when the Control Panel is run, it always uses the memory allocation in the 
'RollCall Control Panel.vmoptions' file.

1.4.2 Command Line Arguments

The standalone version of the Control Panel accepts the following command line arguments.

[-gateway {ipAddress}] [-port {port}] [-u {unitAddress}] [-r {restoreFilename}] [-i {unitID}] 
[-runport {port}] 

For example:

"RollCall Control Panel.exe" -gateway 170.20.31.30 -u 0000:10:01

Note: When using MAC or Linux the default home directory is fixed and cannot be changed.

Note: It is important that the empty text file name is exactly as indicated, including spaces.

-gateway ipAddress The IP address to connect to.
-port portNumber The IP port to use. The default port is 2050. 
-u unitAddress The RollCall address of a unit to autoconnect on startup. 

-r restoreFile The full pathname of a backup file (.rct) to restore to the unit 
specified by unitAddress.

-i unitID Opens the manual for this unit ID.

-runport portNumber

When run in single instance mode, the application binds to a 
server socket on port 52054. Should this socket be coincidently 
in use by another program, the control panel will fail to run. 

A different server socket number can be specified using this 
command line argument. 
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This connects to the gateway whose IP address is set to 170.20.31.30, and opens the 
template for the unit whose RollCall address is 0000:10:01
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2. Screen Layout

2.1 Screen Components

Fig 1. shows the main components.

• Menu - The menu provides access to the functions of the RollCall Control Panel, 
many of which are also accessible via the toolbars immediately below the menu. See 
“Main Toolbar” on page 14.

• Toolbars - There are a number of toolbars. The main toolbar and template toolbar 
display in this area below the menu, and perform as shortcuts to the menu functions. 
Other toolbars form part of other components and are described therein. See “Main 
Toolbar” on page 14.

• Network Browser - This displays a network tree view of all units, enclosures and 
anything that is connected to the selected network. This component has its own 
toolbar. See “Network Browser” on page 33.

• Connected Units - This tab displays all units that have current control connections. 
This component has its own toolbar, called the Unit Toolbar. See “Connected Units” 
on page 44.

• Custom Groups - This tab displays groups of units. Units can be collected together 
into groups, allowing for example: units on different networks to be in separate 
groups; or distinct parts of processes compartmentalized, such that a group contains 
units for one part of a process, giving easy access to units where the number of 
connected units is quite large. See “Custom Groups” on page 48.

• Status Bar - The status bar gives useful information about the network, and memory 
usage. The status bar can be displayed or hidden, set from the View menu. See “View 
Options” on page 12.

• Template Display - This displays opened unit templates. This component has its own 
toolbar, the Template Toolbar. See “Template Display” on page 40.

Fig 1. Main Screen Components

Toolbars

Network 
Browser

Connected 
Units / 
Custom 
Groups

Template DisplayMenu

Status 
Bar
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2.1.1 Customize the Screen

2.1.1.1 View Options

The following may be displayed or hidden by checking/unchecking the checkboxes in the 
View Menu.

• Main Toolbar - Provides shortcuts for many of the main menu functions.

• Template Toolbar - Provides shortcuts for the template display options.

• Status Bar - when displayed, indicates the network status, activity, and memory 
usage.

Within the View menu there are also options to view the templates as windows (allowing more 
than one to display on the screen at once), or as tabs, where each template is selected from 
the tabs at the top of the template display area.

Templates may also be viewed Fullscreen. Alt-Enter toggles the fullscreen and normal 
modes.

2.1.1.2 Resize and Reorder Screen Components

Screen components can be reordered and resized to optimize each for operation.

Fig 2. Component Resizing and Reordering

Use the left and right one-touch arrow buttons to display/hide screen 
components horizontally.

Use the up and down one-touch arrow buttons to display/hide screen 
components vertically.

Grab and drag this control to resize the components horizontally.

Grab and drag this control to resize the components vertically.

Click this button to swap the vertical positions of the Network Browser and 
Connected Units/Custom Groups.

One-touch 
Buttons

Horizontal 
Resizing 
Control

Swap 
Button

One-touch 
Buttons

Vertical 
Resizing 
Control
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2.1.1.3 Color Themes

Color themes are available from the Look & Feel menu.

1. From the menu select the appropriate theme.

A dialog box prompting that the application must be restarted displays.

2. Click Yes to restart the program with the selected color theme, or click No to cancel.

Fig 3. Restart

Important: All connected units are closed upon restart, and must be reconnected manually. Saving 
units into a custom group with auto connect enabled, ensures that the units saved in the 
group are reopened on a restart. See “Add Group” on page 48.
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3. Main Toolbar
The Main Toolbar contains the main functions of the Control Panel. These functions are also 
available through the menus.

3.1 Build Network 

Connect to a network, or directly to a unit, via IP. The units available to connect to from the 
entered IP address display in the Network Browser. See “Network Browser” on page 33.

If the control panel is run as an applet loaded from an IQ modular chassis, the IP address 
defaults to that of the modular chassis.

If the control panel is run as an application, then the first time it is run, the IP address will be 
192.168.151.1.

3.1.1 Build Network Via IP Address

IP addresses are entered in dot-decimal notation or as a DNS entry. The default port number 
is 2050, which is the default port number of the IQ modular chassis. A different port number 
may be specified by appending the port number to the IP address, separated by '@'.

Alternatively, select an IP from the drop-down list. The drop-down list is populated with all the 
IP addresses for which successful connections have been made.

Fig 1. Main Toolbar

Note: When the build network operation is confirmed, any currently connected units will be 
disconnected and, consequently, their templates will be closed.

Fig 2. Build Network
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3.1.2 Add Redundancy

Add a redundant (Secondary) IP address to switch to in case of failure of the Primary IP 
address. The redundant connection is used any time a connection to the specified primary 
address is lost. After switch over to the Secondary IP address there is no automatic return to 
the Primary IP address once the failure has been rectified.

1. Click on the Configure Redundancy button.

The Configure Redundancy dialog displays.

2. Click on the  button to add a new entry for the Primary and Secondary IP 
addresses. 

3. Either, type in a Primary IP address, or select an existing address from the drop-down 
list.

4. Type a Secondary IP address, or select an existing address from the drop-down list.

Any number of such redundancy configurations may be setup by adding extra rows 
into the Configure Redundancy dialog. Add further redundancy configurations if 
required.

To remove an entry, select the row and click the  button.

5. Once complete, click OK.

The Configure Redundancy dialog closes, returning back to the Build Network dialog.

6. Complete the build network operation by clicking OK. 

3.1.3 Build Network Via Serial Connection

To use a serial connection instead of IP connection, select the Serial Connection check box. 
Then, from the drop-down lists select a COM port and specify the baud rate. By default the 
baud rate is 38400.

• Complete the build network operation by clicking OK. 

Note: The Auto Reconnect check box must be checked to enable redundancy.

Fig 3. Configure Redundancy
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3.2 Preferences 

The Preferences dialog contains the following five tabs, each providing a different set of user 
options.

3.2.1 Display Tab

• Multiple Instance - by default, only a single instance of the RollCall Control Panel 
can run on a computer. Select this option to allow multiple instances of the Control 
Panel to run on the same computer.

• Minimize to System Tray - when enabled, minimizing the Control Panel puts it in the 
notification area of the taskbar. The color of the icon indicates whether the Control 
Panel is connected or not. Blue is connected. Red is not connected. This feature is set 
to disabled as a default.

• Show In Browser - use the check boxes to select and display additional information 
for each item in the Network Browser.

• Show Connected User Level - this will display the RollCall user level alongside the 
unit name in Connected Units.

• Show Command Numbers - this will provide the command numbers associated with 
template controls, as a tooltip text. Hover the mouse over any control on an opened 
template and the associated command number will display as a small pop-up.

• Default Window Arrangement - select the relevant radio button to determine how 
multiple templates display as a default. The options are to display as a stack, a 
cascade, or tiled horizontally or vertically.

Fig 4. Preferences - Display Tab
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• Zoom - this option allows the user to zoom in or out of a unit's template.

In order to be able to zoom a template, the Zoom Enabled checkbox must be ticked. 
This must be done before the template is loaded. Because zooming requires addi-
tional system resources, templates are loaded without zoom capability by default.

The zoom range is 50% to 150%.

3.2.2 Manuals Tab

The RollCall Control Panel can access user manuals for itself and for the units that it is 
connected to over a RollCall network. These options are to specify the means by which 
manuals are accessed.

3.2.2.1 Unit Manuals

These options are to specify how the Control Panel accesses unit manuals.

• Remote source - Opens manuals via the SAM Web site. If the computer on which the 
RollCall Control Panel is installed has external internet access select this option to 
ensure access to the most recent user manuals.

• Local Source - Opens the manuals from either a local directory, a network server or 
from the product CD. If the computer on which the RollCall Control panel does not 
have external internet access, select this option. Browse to the local path where the 
unit manuals are stored.

Fig 5. Preferences - Manuals Tab
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3.2.3 IP History Tab

The IP History tab displays a list of IP addresses that the control panel has successfully 
connected to.

• Clear All - Clears the entire history list.

• Clear Selected - Clears only the selected IP addresses in the list.

3.2.4 Cache Tab

Any unit that can be controlled must have a corresponding template and menu set. 

Fig 6. Preferences - IP History Tab

Fig 7. Preferences - Cache Tab
Issue 7 Rev 1 Page 18 ©  2015 SAM



RollCall Control Panel Main Toolbar
Initially, templates and menus are retrieved from units (when a control connection is made) 
and are stored in a local cache.

• Templates are stored by unit type and command set version.

• Menus are stored by unit type, command set version and RollCall user level.

3.2.4.1 Templates

• Load from cache - Templates will be loaded from the local cache. If no cached copy 
exists, they will be loaded from the unit being connected to. 

This is the default setting.

• Load from Unit - Templates will always be loaded from the unit being connected to. 

• Load from File - A template file is prompted for when trying to connect to a unit. A file 
browser dialog displays and a .tpl template file must be selected. 

This is useful for some legacy units that do not carry a copy of the template.

• Delete Template Cache - Pressing this button deletes all cached templates. A 
confirmation dialog indicates the number of templates that will be deleted. Accept or 
cancel as desired.

3.2.4.2 Menus

• Load from cache - Menus will be loaded from the local cache. If no cached copy 
exists, they will be loaded from the unit being connected to. 

This is the default setting.

• Load from Unit - Menus will always be loaded from the unit being connected to. 

• Delete Menu Cache - Pressing this button deletes all cached menus. A confirmation 
dialog indicates the number of menus that will be deleted. Accept or cancel as 
desired.

3.2.5 RollCall Tab

Fig 8. Preferences - RollCall Tab
Issue 7 Rev 1 Page 19 ©  2015 SAM



RollCall Control Panel Main Toolbar
• Broadcast I-AM - enables a gateway to list the Control Panel in its port listing if the 
Control Panel has an Ethernet (or serial) connection to the gateway.

• Wide Area Flag - when selected in conjunction with the Broadcast I-AM option, the 
Wide Area Flag allows the I-AM message to cross RollNet segment boundaries. This 
option has no function unless Broadcast I-AM is also selected.

• Use fast menus, when available - enables the use of fast menus for gateways that 
support them. This significantly decreases the amount of time it takes to download a 
menu from a module. Fast menus, if available, are only available at the supervisor 
level. 

• Port Polling - This option is for use with older gateways that do not support 
connected sessions. It enables the Control Panel to keep module status up-to-date by 
the use of periodic polling. Only use this feature when necessary because it can 
generate a lot of additional network traffic.

• Redundancy Checking - When this option is selected, the Control Panel checks unit 
serial numbers during network discovery to determine the actual physical units 
present on the network, which may differ from the units listed. By doing so, the Control 
Panel can ensure that the operation requested is only performed once per physical 
unit.

If the network is configured such that the same physical unit or units can be seen from 
more than one subnet, selecting this option can eliminate errors that may occur during 
network discovery in instances where the discovery process attempts to open two or 
more views of the same unit simultaneously.

By default, Redundancy Checking is not enabled. 

• User Level - Defines the level of access that a user has in controlling a unit.

Supervisor has the highest level of access, and User has the least, which means that 
access to some of the unit menu functionality will be bypassed. 

• Maximum Block Size - Defines the maximum "file packet length" used in file 
transfers between the control panel and units on the network. This setting should not 
be changed unless advised by SAM engineering. 

• Auto Reconnect - When this option is selected, in the event of failure, the network 
connection will be retried. The default setting for this feature is on.

To change the delay in milliseconds between each retry attempt, enter a value in the 
Auto Reconnect delay box. The range is 0 to 15000 ms. The default value is 2000 ms, 
which can also be entered by clicking the Preset button.

• Keepalive - Checks that the network connection is good. Periodically, a Keepalive 
message is sent to the server at the current IP address. The server is expected to 
respond with an acknowledgement. 

The Keepalive settings determine how quickly a bad network connection is detected. 
If a rapid failure is required, for example when using dual redundancy, the Keepalive 
settings should be set to the minimum values.

Keepalive Interval determines how frequently the Keepalive message is sent, and can 
be set from one second to ten seconds (default setting).

Keepalive Retries sets how many attempts should be made to re-send the Keepalive 
message in the event that no response has been received from the server.

Note: Changing the level does not affect any currently connected units.
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Keepalive Timeout is the duration in seconds (default three seconds) that a response 
is waited for from the server, before re-sending the Keepalive message, if further Kee-
palive Retries have been selected 

• Client Name - this is the name by which the control panel is seen on the RollCall 
network. The client name can be changed to a unique identity. The default setting is 
"ControlPanel".

To change the client name, type the new name in the text box, click Send, then click 
OK.

To return the control panel to the default setting, click Preset and the client name will 
be reset to "ControlPanel".

3.2.6 Loudness Tab

For modular units that have Loudness Metering the colors of the graph elements (loudness 
levels, background, lines, and text) may be changed, and custom color themes saved.

3.2.6.1 Change Graph Element Colors

To change the color of a loudness band:

1. Click on the colored rectangle representing the element to be changed.

The Select Color dialog opens.

Fig 9. Preferences - Loudness Tab
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2. Select the relevant color space tab.

3. Adjust the sliders to change the color characteristics, or click directly on the variable 
color square.

4. Click OK.

3.2.6.2 Custom Color Themes

To save a theme:

1. Adjust one or more colors, then click on either of the Save to Custom... buttons.

A dialog prompting to save the colors to that particular custom button display.

2. Click Yes to Save, or No to discard.

To use a saved custom color scheme:

• Click on the Custom 1 or Custom 2 buttons to select a saved color scheme. Or, click 
on the Factory Defaults button to return to the original default colors.

Fig 10. Adjust Color
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3.3 Import new Upgrades 

1. Save the supplied upgrade package(s) to a network location that can be accessed by 
the Control Panel. Upgrade packages are supplied in a compressed file format (.zip) 
and they should not be extracted.

2. Click on the Import new Upgrades button ( ) in the main toolbar.

The RollCall Upgrade Packages dialog displays. The left-hand panel displays all 
currently available upgrades, grouped by unit type.

3. Click on the Import Upgrade Package button.

Fig 11. Import new Upgrades

Fig 12. Upgrade Packages

Fig 13. Select Upgrade Package

Import new Upgrades
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4. Browse to the folder containing the upgrade package.

5. Select the upgrade package and click OK.

When the package has been imported, it is added to the list of available upgrades, 
and units may be upgraded accordingly. See “Upgrade a Unit” on page 52.

3.4 Licenses 

Some IQ Modular and Conversion products have additional features that can only be used if 
they are licensed. Use the License Viewer to manage the licenses that these products 
require. Each platform has a tab at the top of the License Viewer, and the licenses relevant to 
a platform display in the appropriate tab.

3.4.1 Importing Licenses

License files are contained in .zip archives. Before you can import license files, you must first 
obtain them from SAM and then store them in a network location that can be accessed by the 
Control Panel.

To import license files:

1. Open the License Viewer.

2. Click Import Licenses and then browse to the location of the license files.

3. Select the license files, and click OK. A summary dialog displays.

4. Click OK to close the summary.

After importing licenses, they can be installed to individual units using the Unit License option. 
For more information, see “Unit License” on page 38

3.4.2 Removing Licenses

Licenses are stored by the Control Panel in an internal database. You can remove license 
files from the database if they are no longer required.

To remove license files:

1. Open the License Viewer.

2. Select the license or licenses to be removed, right-click on them and click Remove.

3. A confirmation dialog displays. Click Yes to remove the license or licenses. Click No 
to cancel the operation. A summary dialog displays.

4. Click OK to close the summary.
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3.4.3 Example Licences

If a feature is enabled on a license, a check mark displays in the column below the feature.

3.4.3.1 Modular Licenses

IQ Modular products that support licensed options can have two license types:

• 3G - A 3G license will enable 3Gbps features on certain modules.

• Option Licenses - An option license will enable any or all of several features on 
certain modules.

3.4.3.2 Alchemist Licenses

3.4.3.3 Alchemist Live Licenses

Fig 14. Modular Licenses

Fig 15. Alchemist Licenses
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3.4.3.4 30 Series Licenses

Fig 16. Alchemist Live Licenses

Fig 17. 30 Series Licenses
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3.5 ID Database 

The ID database is an internal database that holds information about how RollCall IDs relate 
to unit type names, information about unit manuals, and other information for the use of SAM 
customer support. The Import RollCall IDs option enables you to import the most recent 
version of the RollCall IDs file, ensuring that your database remains up-to-date.

The ID Database comprises the information in three files:

• Idnames - This file defines the relationships between the Unit ID and the Unit Type 
name. For instance, in the example above, Unit ID 522 (in column 1) is translated to 
IQOTX34 (in column 2).

• Idinfo - This file contains information about each unit ID that is used, for example, 
during unit upgrade, backup, restore, and licensing.

• Manuals - This file provides Unit ID to manual name translation. The third column in 
the table indicates whether a manual is present or not.

To import a new RollCall IDs file:

1. Obtain a new RollCall IDs file (distributed as a .zip file) from SAM and store it in a 
network location that can be accessed by the Control Panel.

2. Click Import RollCall IDs and browse to the location of the file.

3. Select the file and click OK.

4. A confirmation dialog displays.

After updating the RollCall ID Database, restart the Control Panel for the changes to take 
effect.

Fig 18. RollCall ID Database
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3.6 Template Demo 

The Template Demo function enables you to open a template file in the Control Panel without 
being connected to a RollCall network. The template will not be 'live' and any changes made 
to the controls and settings will not affect the physical unit. To open a template in demo mode, 
the template file must be accessible from the Control Panel (for example, in the template 
cache).

To open a template in demo mode:

1. Click Template Demo in the toolbar. The Template Selector displays, listing all 
cached templates. 

2. Select a template to open and click OK. Alternatively, click Open File and browse to 
the template file you want to open. The template opens in demo mode, as shown 
below. 

Fig 19. Template Selector

Fig 20. Template Demo
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3.7 Comms Window 

The Comms Window monitors RollCall packets (messages) transmitted from and received by, 
the control panel. It is used to help diagnose communication problems in a particular RollCall 
network.

The fields in the Comms Window are:

3.7.1 Comms Window Control

Use the Start Capture and Stop Capture buttons to take a snapshot of the messages 
transmitted.

• Tx - enables/disables monitoring of transmitted packets.

• Rx - enables/disables monitoring of received packets.

• Packet Filters - Allows selective monitoring of specific RollCall packet types for both 
transmission and reception. In the Packet Filters dialog, select the packet types to be 
monitored. Select All and Deselect All toolbar buttons are also available.

Fig 21. Comms Window

Timestamp When the packet was received or transmitted.
TxIP / RxIP Transmitted / Received by the Control Panel. 

Src The source RollCall address. This is the address of the sender of 
the packet. The RollCall address format is net/unit/port/index.

Dest The destination RollCall address. This is the address of the recipient 
of the packet. The RollCall address format is net/unit/port/index.

Type The RollCall packet type.
Packet Name As defined by the packet type.
Flags B - back channel packet / W - wide area packet.
Data Specific to the packet type.
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• Address Filters - Allows selective monitoring of packets to and from RollCall units. In 
the Address Filters menu compile a list of addresses to monitor. 

a Type either a single RollCall address or address range in the New address / 
address range box.

b Click Add to add it to the list. Repeat this as required. 

Selectively remove addresses or address ranges from the list by highlighting the item 
in the list and clicking Remove. To monitor all addresses (the default) click Include 
All to remove all addresses from the list. An empty list means monitor all addresses.

• Copy All - Copies the current contents of the Comms Window to the clipboard.

• Clear - Deletes the contents of the Comms Window.

• Always on Top - Keep the Comms Window in front of all other windows. This is 
useful when using a single computer monitor and needing to watch the Comms 
Window while interacting with the control panel.

Fig 22. Packet Filters

Fig 23. Address Filters
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3.8 Control Panel Manual 

Displays this User Manual. A PDF viewer, such as Adobe® Acrobat® will be needed to view 
this, and all product manuals.

3.9 About 

The About dialog contains information relating to the Control Panel software release, System 
Information (the computer being used) and Acknowledgements.

• Release Version - The release version of the Control Panel.

• Components - Internal component versions.

• Release Information - Highlights the new functions, features and options that apply 
to the software.

• System Information - Information contained in this dialog relates to the computer 
that the Control Panel software is being used on. 

Fig 24. About RollCall Control Panel

Fig 25. System Information
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• Acknowledgements - Lists the third party libraries used in the Control Panel and 
provides copies of their licenses.

Fig 26. Acknowledgements
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4. Network Browser
When a network connection is initially established, the Network Browser will show the top 
level nodes in the network.

A node displayed in italics, indicates that the unit is serving as the IP connection for the 
Control Panel.

A node displayed in bold, indicates that it has an open template.

4.1 Browser Icons

The following icons are used to graphically illustrate the components of the RollCall Network:

Fig 1. Network Browser

Bridge unit, which links to another RollCall network. This may be a physical bridge 
device, or a virtual bridging element such as the RollCall IP Proxy.
Bridge unit - expanded
Unit with sub-units, for example, modular chassis
Unit with sub-units - expanded
Unit with sub-units - non controllable state
Unit with sub-units - non controllable state - expanded
Module
Module - non controllable state
Stand-alone unit with no sub-units
Stand-alone unit - non controllable state
This icon indicates that the unit is being controlled by a remote control panel, and is 
available for other control panels to connect to (multi-session)
This icon indicates that the unit is being controlled by a remote control panel, but is 
not available for other control panels to connect to (single-session)
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4.2 Discover Network

When the RollCall Control panel initially connects to a RollCall network, only the top level 
nodes display. The Control Panel does not display any of the units below the displayed level, 
until the units are discovered. This is done to improve the performance of the Control Panel 
by reducing the amount of information that needs to be gathered about the network - some of 
which may not be needed by the user.

For example, in the case of an extremely large network, it may take up to several minutes for 
the RollCall Control Panel to gather the information to fully display the network. However, the 
user may only wish to view a single unit on the network. In this instance, it is not necessary for 
the Control Panel to discover the entire network; instead, the Control Panel only needs to be 
aware of the unit to which the user wants to connect (and naturally those that are above it in 
the tree structure). Therefore, it is useful to be able to only discover, and subsequently 
display, parts of a network.

Once a network component has been discovered, it will remain so for the remainder of the 
currently connected RollCall Control Panel session.

4.2.1 Manually Discover a Network

Any node with a  sign next to it can be discovered and expanded, either by clicking on the 
 sign or by double-clicking on the name. The figure below shows a partially expanded 

network.

There are two toolbar buttons at the top of the network browser that are used to discover the 
RollCall network.

4.2.2 Discover Network - All Units 

The Discover Network - All Units button (large binoculars) polls the entire RollCall Network 
and gathers information about everything that is connected to it. Depending on the size of the 
RollCall network, this process can take several minutes to complete.

Click the Cancel button while the discovery process is running to interrupt the discovery 
process, if required.

After a network has been discovered, the network tree displays fully expanded. 

Note: If the network is configured such that the same physical unit or units can be seen from 
more than one subnet, it is possible that during the network discovery process the Control 
Panel may attempt to open the same physical unit (on different subnets) simultaneously, 
causing an error to occur. Enabling the Redundancy Checking option in the RollCall 
preferences can prevent this error from occurring.

Fig 2. Manually Discover a Network
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4.2.3 Discover Network - Gateways Only 

The Discover Network - Gateways Only button (small binoculars) polls the RollCall Network 
tree and gathers information down to the Gateway level. Anything below the Gateway level 
must be discovered by manually expanding the relevant Gateways. This option does not take 
as much time as Discover Network - All Units.

Click the Cancel button while the discovery process is running to interrupt the discovery 
process, if required.

After a network has been discovered, the network tree is displays fully expanded. 

The Expand Tree and Collapse Tree buttons do not perform any function with regard to 
network discovery. Their only purpose is to change the visual representation of the network 
tree view.

4.2.4 Expand Tree 

This button fully expands all of discovered network components in the view. Before a network 
node can be expanded, it must first be discovered.

4.2.5 Collapse Tree 

This button fully collapses the network view. Any units that have already been 'discovered' will 
remain so for the remainder of the currently connected session.

4.2.6 Create Snapshot of Tree 

Records a snapshot of the current state of expanded and collapsed components in the 
network tree.

4.2.7 View Snapshot of Tree 

Recalls the last recorded snapshot of the network tree, and changes the network tree so that 
it displays as it was when the snapshot was created. If no previous snapshots have been 
created this button is not enabled.

4.2.8 Connect To 

To directly connect to a unit using its RollCall address:

• Click the Connect To button, and enter the address of the unit. 

This is an alternative mechanism to connecting to a unit via the network browser.

Note: Rebuilding the network deletes any existing snapshot.

Fig 3. Connect to a Unit
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4.3 Opening a Template

A template for a unit can be opened by using its context menu.

• Right-click on a unit to show its context menu as a pop-up, and click on Connect.

If the unit is currently busy, denoted by , the Busy Unit dialog box displays.

• Click OK to disconnect the current user of the unit and open the template, otherwise 
click Cancel.

The context menu display options available for the specific unit type. For example, the Unit 
License option is only shown if the unit supports licensed options.

• To connect to modules and units with no sub-units, double-click on them.

The context menu of a connected unit is shown below:

Many of the functions in the context menu of a connected unit are replicated in the Unit 
Toolbar which is described in the Connected Units section. See “Connected Units” on 
page 44.

Fig 4. Open a Template

Fig 5. Context Menu
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4.4 Edit Unit Name

The name of any gateway or module in the Network Tree can be edited.

To edit the name of a unit:

1. Right-click on the unit in the Network Tree and click on Edit Unit Name. Alternatively, 
select the unit and press the F2 key.

A text entry box displays in place of the unit name.

2. Type a new unit name in the text box and press the Enter key to accept; or, press the 
Esc key to cancel the action. Names have a maximum length of 19 characters.

To return a unit to its default name:

• Delete all of the text in the text entry box and press the Enter key.

When a gateway is also acting as a bridge, it displays as having two nodes in the network 
tree. One node is shown as the gateway  and the other is shown as the bridge . By 
default, both nodes share the same unit name.

To alleviate confusion, a naming convention exists to allow separate names to be given to the 
gateway.

If the unit name contains a tilde (~) character, the text before the ~ will be used as the 
gateway name and the text after the ~ will be used as the bridge name. (Note that the 19 
character length restriction still applies).

For example, the name Gateway~Bridge, displays: 

Fig 6. Edit Unit Name

Fig 7. Gateway Name
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4.5 Unit License

If a unit supports licensed options, right-click on the unit, and click on Unit License to open 
the Unit License dialog.

The Unit License dialog displays the currently installed licenses for both 3G and Licensed 
Options as well as any available licenses in the licensing database.

Before installing a license, first import it to the license database. For more information, see 
Licenses on page 20.

In the above example, the IQMUX33 does not have any licensed options enabled. However, 
two licenses are available, one for 3G and one for up-mixing, Dolby® decoding and Dolby® 
encoding.

To install licenses:

1. Select the licenses to install and click on Install Licenses.

2. In the confirmation dialog that displays, click Yes to install the licenses. To cancel the 
operation, click No.

A confirmation dialog displays, prompting for the module to be restarted. The licenses 
will not be valid until the module is restarted.

3. Click Yes.

The Unit License dialog closes. When the unit has restarted the new licenses will be active.

Fig 8. Unit License
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4.6 Additional Context Menu Items

The following menu items are also displayed for some SPI and GPI modules:

Download Setup - Load a previously saved Setup File to the current module.

Extract Setup - Save the current configuration of a module as a Setup File.

Download Template - Load a previously saved Template File to the current module.

Extract Template - Save the current module template as a Template File.

Fig 9. GPI and SPI Module Menu Items
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5. Template Display
This is the main area in which open templates display. The template toolbar above the main 
area provides functions affecting how templates display. This is particularly useful when 
multiple templates are open. These functions are also available through the menus.

5.1 Templates

When a unit from within the network browser has been connected to, a template for this unit 
displays in the Template Display. The template provides all the controls relating to the unit.

5.1.1 Navigating Template Pages

The template, depending on the type of unit, may have a number of pages, each of which can 
be selected from the list at the top left of the display area.

5.1.1.1 Rapid Page Selector

Right-click in any part of an opened template, to display a pop-up providing quick access to all 
of the template pages.

Fig 1. Template Pages

Pages

Fig 2. Rapid Page Selector
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5.2 Template Toolbar

The following toolbar is provided for the template display.

5.2.1 Fullscreen 

This button which switches the Template Display to fullscreen mode. In fullscreen mode, the 
Template Display occupies the full RollCall Control Panel window - the toolbars, Network 
Browser and Connected Units are obscured.

To return to normal mode, select Full Screen from the View menu. Alternatively, use the 
keyboard shortcut Alt-Enter to toggle between fullscreen mode and normal mode.

5.2.2 Tabbed View 

This is a toggle button which switches between windowed view and tabbed view. In tabbed 
view, opened templates display as a sequence of tabs running along the top of the template 
display, as shown below.

5.2.3 Previous/Next  

Selects the previous or next non-minimized template. The order of selection is the same as 
the order in which the templates were opened.

5.2.4 Cascade 

Displays all non-minimized templates as a cascade. This is the default setting.

5.2.5 Tile Horizontally 

Displays all non-minimized templates in a horizontal tile.

Fig 3. Template Toolbar

Fig 4. Tabbed View

Fig 5. Cascade
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5.2.6 Tile Vertically 

Displays all non-minimized templates in a vertical tile.

5.2.7 Stack 

Maximizes all non-minimized templates. Only the active template is visible. Use the template 
selector to switch between templates.

5.2.8 Minimize/Un-Minimize  

Minimize - minimizes all opened templates.

Un-Minimize - restores all opened templates.

Fig 6. Tile Horizontally

Fig 7. Tile Vertically
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5.2.9 Template Selector 

This drop-down list (available when one or more templates are open) allows for quick 
switching between open templates.

Select the required template from the drop-down list, and that becomes the active template, 
irrespective of how the templates are displayed, or if the template has been previously 
minimized.

5.3 Set Values

Many of the settings within the templates have values, either numerical, or textual.

Numerical values are set by using the associated slider to position the pointer at the value 
required. Alternatively, clicking directly on the value opens that field for editing. The current 
value may be deleted, and a new value entered.

When setting a value in a field the value, whether text or a number, must be set by pressing 
the Enter key (or by clicking on the  button, if available).

To cancel the edit, either press the Esc key, click on the background panel, or click on another 
control.

Clicking on an associated  button returns the value back to the factory default setting.

Fig 8. Set Values
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6. Connected Units
This tab displays all the units that have control connections; that is, have templates opened in 
the Template Display.

Each entry in the list displays the unit address, the unit name and optionally the RollCall user 
level it is connected at. Each entry also has an icon to denote the unit class and an icon to 
denote the unit status (see the Network Browser section for more details on icons).

Each unit has an associated context menu. Right-click on an entry to show its context menu in 
a pop-up.

The functions in the pop-up menu are replicated in the Unit Toolbar. 

6.1 Unit Toolbar

This toolbar is active when one or more units display in the Connected Units list. The toolbar 
functions are described below.

6.1.1 Disconnect All 

Terminates control connections for all units. Closes all currently opened templates.

Fig 1. Connected Units

Fig 2. Context Menu

Fig 3. Unit Toolbar
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6.1.2 Disconnect Unit 

Terminates the control connection for the currently selected unit, and closes its template.

6.1.3 Unit Information 

Displays information related to the currently selected unit. 

6.1.4 Unit Manual 

Displays the manual for the currently selected unit.

6.1.5 View Menuset 

Displays the menu set for the selected unit. 

• Index - Unique line number for the menu entry. 

• Name - The name displayed.

Fig 4. Unit Information

Note: A + symbol shown next to Menu indicates that the unit supports fast menus.

Fig 5. View Menuset
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• Command - The command number.

• Style - What kind of menu entry, for example, number, checkbox, display, etc., or a 
structural entry.

• Min - The minimum value that the entry can take.

• Max - The maximum value that the entry can take.

• Step - The size of the increment for a numeric control.

• Scale - The scaling for a numeric control.

• Format - The formatting for a numeric control.

• Cacheable - Whether this menu entry can be cached or not.

• Hidden - The current visibility of the menu entry.

• Disabled - The current enabled state of the menu entry.

• Wraps - Whether the control value should wrap around when it has reached its 
maximum or minimum.

6.1.6 Open Duplicate 

This opens a duplicate template for the currently selected unit.

6.1.7 Save 

To save the state of the currently selected unit:

• Click on the Save button to save the unit state to the default backup folder, or

• Click the Save To function to save the state of the unit to a named file in a selected 
directory.

Note: Not all menu entries correspond to controls. There are those that only impart structure to 
the menu set. 

Fig 6. Save Setup
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6.1.8 Restore 

To restore the state of the currently selected unit:

• Click on the Restore button to restore the unit state from the default backup folder. If 
the Restore button is not enabled, the unit does not have a backup file in the default 
folder, or

• Click on the Restore From button to restore the state of the unit from a named file in 
a selected directory.

Many unit types support user defined memories. For such unit types, the user memories may 
be restored or not, as required. 

It is possible to clone units using the restore function, for example, to copy current settings 
and user memories from one unit to another. Certain conditions have to be met, such as 
whether the unit types match and possibly the command set versions.

Copying user memories requires copying the entire state of a unit, including factory data such 
as serial number and calibration. The Control Panel makes sure that factory data is not 
overwritten but for a unit that requires a restart, the clone process will not be complete 
until the unit comes back online.

6.1.9 Refresh Page 

Re-acquires all of the command values on the current page of the template, for the currently 
selected unit.

Fig 7. Restore Setup

Note: Some older unit types do not support restore of user memories.

Fig 8. Restore Setup Method

Note: Some unit types require a restart to complete the restore.

Fig 9. Restart Unit
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7. Custom Groups
Units can be allocated to groups to represent a specific workflow so that they can be 
accessed quickly. Groups can also be created from different networks.

• Click on the Custom Groups tab.

7.1 Group Toolbar

This toolbar is applicable to all units in the current Custom Group.

7.1.1 Add Group 

Adds a new group. The Add Group dialog displays.

1. Enter a name for the group, and select the Window Arrangement preference for when 
the group is relaunched.

Each new group displays as a tab underneath the Group Toolbar.

Fig 1. Custom Groups Tab

Fig 2. Group Toolbar

Fig 3. Add Group
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2. To add units to a group, either drag and drop from the Network Browser, select demo 
units from the Template Demo dialog, or select  from the Unit toolbar.

3. Add the IP address for the network on which the units reside.

4. If required, check the Auto connect group when net connection established checkbox.

Example 1: Units from a network based on the Playout Channel

Channel 1, Channel 2, TV2, TV2+1, Channel 1 North, Channel 1 South

Example 2: Units based on functionality

Down Converters, Distribution, Synchronizers, ARCs, UDCs, Emergency Switches

Each entry in the list displays the unit address, ID, type and the unit name. If the unit is 
connected, the connected icon( ) displays in the left column.

An invalid unit, for example a selected unit that is not on the same network as the group, 
displays red.

7.1.2 Remove Group 

Deletes the current group. The units within the group are still available from the other views 
within the RollCall Control Panel.

7.1.3 Edit Selected Group 

Displays information related to the currently selected group. 

• Edit the Group name and Window Arrangement accordingly, and click OK.

7.1.4 Connect Units 

Connects all units in the current group. 

Note: Drag and drop functionality is not available when running on MAC OS X.

Fig 4. Custom Groups
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7.1.5 Disconnect Units 

Disconnects all units in the current group. 

7.1.6 Refresh 

Refreshes the status of all units in the current group, giving an up-to-date health check on all 
units in the group.

7.1.7 Export Group to File 

Exports the current group to a file. 

7.1.8 Export All Groups to a File 

Exports all groups to a file.

7.1.9 Import All Groups From a File 

Imports groups from a previously saved file.

7.1.10 Move Groups

Groups can be reordered by dragging and dropping the group name tab.

7.2 Unit Toolbar

This tool bar is applicable to the individual units within a group. The toolbar functions are 
described below.

7.2.1 Add Unit 

Displays the Add Unit dialog.

• Enter the RollCall Address for the unit, and select the RollCall ID from the drop-down 
list. Click OK.

7.2.2 Add Demo Unit 

See “Template Demo” on page 28.

7.2.3 Remove Unit 

Remove the currently selected unit from the group.

Note: Exporting Groups to a file provides a backup of the group configuration, and gives the 
ability to import the groups to another client.

Note: Drag and drop functionality is not available when running on MAC OS X.

Fig 5. Add Unit
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7.2.4 Edit Unit 

Edit the currently selected unit.

7.2.5 Connect Unit 

Connect the currently selected unit.

7.2.6 Disconnect Unit 

Disconnect the currently selected unit.

7.2.7 Refresh Unit 

Refreshes the currently selected unit, and updates its status.

7.2.8 Move Unit Up 

Moves the currently selected unit up one place in the list.

7.2.9 Move Unit Down 

Moves the currently selected unit down one place in the list.
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8. Upgrade Units
Units can be upgraded when a newer version of software exists. Upgrade packages are 
supplied by SAM.

8.1 Upgrade a Unit

A unit can only be upgraded if an appropriate upgrade package is available. See “Import new 
Upgrades” on page 23.

1. Right-click on the unit name in the Network Browser.

2. The unit menu displays.

3. Click on Unit Upgrade from the unit menu. 

The Unit Upgrade dialog displays.

Fig 1. Unit Menu

Fig 2. Unit Upgrade Dialog

Unit 
Menu
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The following elements and options are available:

• Unit - This panel displays the unit address, serial number, and hardware version (if 
available).

• Pre Upgrade - This panel displays the unit name, unit type, unit ID, unit version and 
loader version of the unit before the upgrade.

• Options - Choose to either upgrade only the files that have changed or to upgrade all 
files. It is recommended that the Upgrade Changed Files Only setting is used to 
ensure a fast upgrade. However, some units may ignore this setting, and always 
upgrade all files.

• Post Upgrade - After completion of the upgrade, this panel displays the new unit 
name, unit type, unit ID, unit version and loader version.

• Software Releases - This drop-down list shows all of the software releases available 
for the unit type. Note that before any releases can be shown, software releases must 
be imported using the Import new Upgrades function available from the main toolbar.

• Release Notes - If release notes are available, clicking this button displays them. If 
release notes are not available, this button is not displayed.

• Upgrade Log - This displays the progress of the upgrade.

• Cancel - This closes the Unit Upgrade dialog. If an upgrade is in progress, 
confirmation of this action is requested.

• Upgrade - If a software release has been selected, this starts the upgrade process. 
Prior to the upgrade process beginning, a check is made to see whether the unit's 
current version is available in the list of software releases. If not, a dialog displays 
prompting to save the unit's current software release before upgrading. 

If the unit is providing the IP connection then the network is temporarily lost, but is 
restored on completion of the upgrade.

• Import upgrade from unit - This creates a software release from the version 
currently on the unit. Note that this option is only displayed if the unit's version is not 
already in the list of software releases.

At the end of the upgrade, if the unit does not come back online, a dialog displays.

Further attempts are made to establish contact with the unit until it either, comes back online, 
or the Cancel button is pressed.

Cancelling this operation has no effect on the success or otherwise, of the upgrade operation.

Note: The control panel cannot be used while performing an upgrade.

Fig 3. Unit Upgrade Dialog

Note: It is currently not possible to detect the true completion of an upgrade to a 30 Series 
Modular Converter. At the point where upgrade appears to be complete, the unit is starting 
to create and install the new version. This can take some time to complete (at least five 
minutes, probably longer); after which time, the unit will automatically restart itself. For this 
reason, the Post Upgrade information always displays as Unknown.
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8.2 Upgrade History

Every time an upgrade is performed, whether successful, aborted or cancelled, an entry is 
made into the upgrade history file. This file is a record of upgrades and cannot be edited.

Each entry contains the following information:

• Timestamp

• Serial Number

• Hardware version (if available)

• RollCall Address

• Unit Name pre-upgrade

• Unit Type pre-upgrade

• Unit ID pre-upgrade

• Unit Version pre-upgrade

• Upgrade Package, this can be one of the following:

• The name of the original .zip file from which the release was imported.

• The RollCall address of the unit from which the release was imported.

• Unit Name post-upgrade

• Unit Type post-upgrade

• Unit ID post-upgrade

• Unit Version post-upgrade

Fig 4. Upgrade History
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Appendix 1. XY Panel

1.1 XY Panel Control

The XY Panel is a RollCall Control Panel screen for setting up and changing routes on a 
connected router, or a device with a router behavior, for example, an IQSPI00 card configured 
to act as a router controller, or simulator. The XY panel described here is the default 
configuration and may vary according to the device that is connected. Also, the means of 
access to this XY panel may differ according to the implementation of the device.

The Routing tab is the default display when opening the XY Panel. See “Routing” on page 55.

1.1.1 Popout

The Popout button ( ) removes the XY Panel from the RollCall Control Panel and displays it 
in a new window, according to the configuration set in the Popout Display options. See 
Popout Display on page 62.

1.1.2 Routing

The Routing tab is used to set up routes from sources to destinations. 

Fig 1. Example Popout Display
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Routes can be set up to either occur immediately as soon as the route is made, or upon the 
click of a Take button.

An Undo button can be added to the display so that a route may be undone. When the Undo 
button is set up an Undo Timeout is included. The timeout specifies the duration after routing 
in which it is still possible to revert back to the state before the route was made.

The Undo button is available whether routing immediately or when using a Take button.

The Take button, Undo button and Undo Timeout are set up in the Options tab. See Router 
Functions on page 61.

1.1.2.1 Navigating the Routing Tab

Use the slider bars under the source and destination panels to navigate forward and reverse 
through the pages.

Navigating to another page of sources or destinations, displays a button indicating on which 
page the currently routed source or selected destination is on.

Fig 2. Routing Tab

Sources

Destinations

Route Information

Destination Protect Status

Panel Lock/Unlock

Fig 3. Panel Pages

Current source 
page

Current destination 
page

Currently routed source 
on this page

Currently selected 
destination on this page
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• Click on the button to navigate directly to the page of the currently routed source or 
selected destination, as applicable.

1.1.2.2 Filter the Router Display

Filters can be applied to destinations and sources limiting the number viewed. The filtering is 
switched on in the Options tab. See Router Display on page 61.

To apply a filter to either destinations or sources: 

1. Hover over the Filter text entry box.

The Filter functions display.

2. Click on the appropriate Contains or Starts With radio button.

3. Type in the desired filter text in the text entry box. The display changes accordingly as 
characters are typed.

To clear the filter:

• Click on the Clear button.

1.1.2.3 Set a Route

To set a route:

1. Click on a destination button.

The destination, and current source, if previously set, display in the Route Information 
area.

2. Click on the source button from where to route.

3. Click on the Take button, if displayed.

To set another route, click on another destination button.

Fig 4. Filtering

Fig 5. Route Information

New source 
(requires a 
Take in this 
example)

Current 
source

Current destination
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Clicking on the currently selected destination deselects the destination and returns 
the display to the default state.

1.1.2.4 Destination Protect

Destinations may be protected so that the a new route cannot be applied to that destination 
without the protection first being removed. 

To protect a single destination:

• Click on the destination button to protect, and click the Protect Dest button.

The closed padlock symbol displays on the button indicating that the destination is 
protected.

In addition a padlock icon ( ) displays on the destination button when in protected 
state.

To unprotect a destination:

• Click on the destination button, and click the Unprotect Dest button.

The open padlock symbol displays on the button indicating that the destination is 
unprotected.

The padlock icon on the destination button is removed.

To protect multiple destinations:

• See Edit Protect on page 59.

1.1.2.5 Panel Lock

The panel can be locked to prevent further routing.

To lock the panel:

• Click the Panel Unlocked button.

To unlock the panel, allowing routes to be set:

• Click the Panel Locked button.

1.1.2.6 Button Maps

Button maps are used to control access to certain parts of a router.

By default the button map view is set to off, and all of the router is accessible. To use button 
maps they must be enabled in the Options tab. See Router Functions on page 61.

Once enabled, the button map selector displays at the top of the tab. The button map selector 
also displays at the top of the Edit Names and Edit Protect tabs.

Until a button map is created the button map selector is empty, and no part of the router is 
visible. To create one or more button maps, see “Button Maps” on page 66.

Note: Deselecting a destination does not affect its routing.
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If the XY panel starts up with button map view enabled, a button map must be selected from 
the button map selector. If there is only a single button map defined then this is automatically 
selected, and the view displays accordingly.

1.1.3 Edit Names

Use the Edit Names tab to assign names to the sources and destinations. 

To edit the names of the sources and destinations:

1. Click on the Edit Names tab.

2. Click on a button.

3. Type a new name, and press the Enter key.

Pressing the <Esc> key will cancel an edit.

1.1.4 Edit Protect

Define destinations to protect or unprotect in the Edit Protect tab.

Fig 6. Button Map

Button Map 
Selector

Fig 7. Edit Names
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To protect/unprotect destinations:

1. Click on the Edit Protect tab.

2. Click on a destination button to toggle the protect state. A padlock icon ( ) displays 
on the button when in protected state.

1.1.5 Options

The Options tab provides settings for customizing the display of the XY panel.

The Options tab has two modes: User Mode and Admin Mode, as indicated by the radio 
buttons at the bottom of the screen.

The features in the Options tab are only available when in Admin Mode.

When connecting to a unit the XY panel always starts in User Mode. 

1. Click on the Admin Mode radio button to gain access to the options.

Fig 8. Edit Protect

Note: Settings are store per client. They are not stored between clients.

Fig 9. Options
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Initially, Admin Mode is unsecure (no password). If required, a password can be set 
for Admin Mode, see “Manage Options” on page 71. The Admin Mode radio button 
then indicates that it has password protection.

2. If a password is requested, enter the password, and click OK. 

1.1.5.1 Router Functions

Define Take and Undo buttons to be included in the Routing page.

• Check the Preselect with a Take button checkbox to add a Take button to the 
Routing page.

If no Take button is added, routing takes place immediately on selection of a source.

• Check the Undo checkbox to add an Undo button to the Routing page.

Add a timeout to the Undo by moving the slider. The time set is the period after per-
forming a Take operation (with or without a Take button) in which an Undo operation is 
possible, returning to the previous route before the Take. Once the timeout time has 
elapsed the Undo operation is no longer possible.

1.1.5.2 Router Display

Define which additional information displays on the source and destination buttons in the 
Router page.

• Show Port Index—Displays the Port Index number on each button.

• Show Source Reference—Displays reference input standard information about the 
data type, for example, the format of the source.

• Show Dest Protect—A padlock icon ( ) displays indicating that a destination is 
protected.

• Filters—Displays the Filtering functions on the Routing page. 

• Button Map View—Enable Button Map View. Button Maps can then be created and 
selected from the Routing Page. See “Button Maps” on page 66.

• Disable Routing Page—Disable the Routing tab so that further routes cannot be 
made. This feature is not available on modular products.

• Disable Edit Names—Disables the Edit Names tab, so that source and destination 
names cannot be edited by users.

• Disable Protect Edit—Disable the Edit Protect tab, so that destination protects 
cannot be edited by users.

Note: Once in Admin Mode, the Options tab remains in this mode unless User Mode is 
re-selected, or the unit is disconnected.

Fig 10. Router Functions
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1.1.5.3 Popout Display

Customize the display of the XY Panel for when it is used as a popout.

The following aspects of the display can be customized:

• Logo Display—a floating logo that can be repositioned anywhere within the window, 
excluding the area of the Panel Display.

• Title Display—a floating title that can be defined and repositioned anywhere within 
the window, excluding the area of the Panel Display.

• Panel Display—the background of the XY Panel can be setup with a 
semi-transparent color or image.

• Window Display—the background of the window can be setup with a 
semi-transparent color or image.

Fig 11. Router Display

Fig 12. Popout Display Setup
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Logo Display

To add a logo:

1. Click the Browse button ( ) and navigate to the logo image.

2. Check the Show Logo checkbox.

The logo displays next to the top right of the Panel Display.

To move the logo:

• Double-click on the logo and drag to another position.

The logo cannot be positioned on the Panel Display.

• Click on the Reset Position button to move the logo back to the original position.

Title Display

To add a title:

1. Edit the text to name the panel.

2. Check the Show Title checkbox.

The title displays to the right of the Panel Display.

3. Click on the Font button to change the font, size, and style of the text.

To move the title:

• Double-click on the title and drag to another position.

The title cannot be positioned on the Panel Display.

• Click on the Reset Position button to move the title back to the original position.

Fig 13. XY Panel Popout Display

Logo Display

Title Display Window Display

Panel Display
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To change the color of the title:

1. Click on a color box.

2. Select the desired color from dialog box that displays.

3. Click OK.

The four color boxes define the colors for the text background and the text itself (fore-
ground). Choosing two different colors for either the background or foreground dis-
plays a gradation between the two colors selected.

4. Use the Transparency slider to determine the opacity of the background color.

Panel Display

To change the color of the panel background:

1. Click on a color box.

2. Select the desired color from dialog box that displays.

3. Click OK.

Choosing two different colors for the background displays a gradation between the 
two colors selected.

4. Use the Transparency slider to determine the opacity of the background color.

To add a background image to the Panel Display:

1. Click the Browse button ( ) and navigate to the image.

2. Check the Show Wallpaper checkbox.

3. Check the Tile checkbox, if required.

Adding a background image overrides the background color and transparency set-
tings. The image cannot be made semi-transparent.

Window Display

To change the color of the panel background:

1. Click on a color box.

2. Select the desired color from dialog box that displays.

3. Click OK.

Choosing two different colors for the background displays a gradation between the 
two colors selected.

To add a background image to the Panel Display:

1. Click the Browse button ( ) and navigate to the image.

2. Check the Show Wallpaper checkbox.

3. Check the Tile checkbox, if required.

1.1.5.4 Button Sizes

From this dialog, the source and destination buttons in the panel display can be resized, the 
fonts for the button text changed, and the sample channel naming display set.

To change button sizes:
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• Use the horizontal and vertical sliders to increase/decrease the button sizes.

The display changes accordingly, graphically showing the actual size and shape of 
the buttons.

The following options are also available:

• Checking the Link source and dest button sizes checkbox makes the source and 
destination buttons increase/decrease at the same time, with a matching size.

• Checking the Preserve aspect ratio checkbox allows the button sizes to be 
changed using either the horizontal or vertical slider to alter the size of the 
buttons in both axes, whilst maintaining the current shape of the buttons.

• Checking the Auto resize channel names checkbox ensures that as the size of 
the button increases/decreases the channel name font size changes dynamically 
to fit the name inside the current size of button, to a minimum of 9pt, and up to 
the maximum of the font size selected.

• Click the Default button to return a button to default size.

To change fonts:

1. Click on one of the text element font buttons.

The Fonts dialog displays.

Fig 14. Button Sizes
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2. Select the font name and size as required.

3. Click OK.

The Fonts dialog closes, and the buttons are updated accordingly.

• Click on the Default button adjacent to a font to return to the default values.

To set the display of sample channel names:

• Select the appropriate radio button to select the channel name length to display. 
Choose from 8-character, 16-character, 32-character, or a custom name.

• If the custom names are used, the sample names for sources and destinations can be 
edited in the fields at the bottom of the dialog.

1.1.5.5 Panel Sizes

Adjust the number of columns, rows and the size of the gaps between the buttons, for both 
the source and destination panels, either individually or both together.

1.1.5.6 Button Maps

Use button maps to define alternative mappings of the source and destination buttons. Map 
some or all of the buttons to limit the number of source and destination buttons visible on the 
router displays, and/or the order in which they are displayed.

Fig 15. Button Font

Fig 16. Panel Sizes
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Create a Button Map

1. From the Button Map dialog, click on the Create button.

2. Enter a name in the Input dialog.

3. Click OK.

The Create Button Map dialog displays.

Fig 17. Button Maps

Fig 18. Input Name

Fig 19. Create Button Map
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4. Map a button by first selecting the desired position in the custom set of buttons (the 
lower set), then select a button from the default set of buttons (the upper set).

A copy of the default button displays at the new custom position. After assignment, 
the next custom button is automatically selected - this is to allow rapid assignment of 
a sequence of buttons. 

Any custom buttons that remain unmapped will not display when the button map is in 
actual use.

To edit the button mappings, either:

• Right-click on a mapped button, and the following menu options display.

Deallocate—Remove the mapping from the selected button, allowing the button to be 
remapped.

Insert—Inserts a new unmapped button at the current position. Mapped buttons from 
the current position onwards are moved up one position.

Move Up—Moves the selected button up one position.

Move Down—Moves the selected button down one position.

or,

• Right-click on an unmapped button, and the following menu options display:

Note: A default button cannot be assigned to more than one custom position.

Fig 20. Mapped Buttons

Fig 21. Button Map Menu (Mapped Button)
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Delete—Removes the unmapped button at the current position. Mapped buttons from 
the current position onwards are moved down one position.

Insert—Inserts a new unmapped button at the current position. Mapped buttons from 
the current position onwards are moved up one position.

5. Click OK to finish the button map creation and return to the Button Map dialog.

Button maps are stored locally on the client.

Edit a Button Map

• From the Button Map dialog, select a button map name and click on the Edit button.

The Edit Button Map dialog displays, and the mappings can be adjusted in the same 
manner as described when creating a button map.

Rename a Button Map

1. From the Button Map dialog, select a button map name and click on the Rename 
button.

2. Type a new name, and click OK.

Delete a Button Map

• From the Button Map dialog, select a button map name and click on the Delete 
button.

Import a Button Map

1. From the Button Map dialog, click on the Import button.

2. From the Import Button Map dialog that displays, navigate to, and select, the 
appropriate button map file (in the form of a .ini file).

3. Click on the Import button.

Export a Button Map

1. From the Button Map dialog, select a button map name and click on the Export 
button.

Fig 22. Button Map Menu (Unmapped Button)

Fig 23. Import Button Map
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2. From the Export Button Map dialog that displays, navigate to the appropriate folder to 
save the button map to.

3. Type a File Name.

4. Click on the Export button.

5. The button map is exported as a text file (.ini) containing the relevant mappings.

Move Up

• From the Button Map dialog, select a button map name and click on the Move Up 
button.

This moves the selected button map up one position in the list.

Move Down

• From the Button Map dialog, select a button map name and click on the Move Down 
button.

This moves the selected button map down one position in the list.

Remote Storage

Some unit types support the ability to store button maps on the routing device itself. In this 
case, an additional Show Remote >> button displays on the Button Maps dialog.

• Click on the Show Remote >> button to display the button maps saved on the routing 
device.

Fig 24. Button Maps
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Button maps that display in the Available Button Maps list can be copied to the routing 
device’s remote storage area by dragging it into the Remote Button Maps list and dropping it 
there. Button maps can also be copied from the remote storage area to the Available Button 
Maps list in a similar way.

Button maps stored remotely can be renamed or deleted. Remote button maps cannot be 
edited directly. To edit a remote button map it must first be copied locally.

1.1.5.7 Manage Options

• Restore all settings back to the factory default settings.

• Save the current settings to a file.

Fig 25. Remote Button Maps

Note: On a dual-redundant system remote button maps are not replicated between the two 
controller cards. In the instance of a failover the router device can be repopulated with 
button maps from the local client.

Fig 26. Manage Options
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• Load a settings file previously saved.

• Add or change the Admin Mode password for gaining access to the features in the 
Options tab. If the password is deleted here, Admin Mode returns to being unsecured, 
and will be indicated as such on the radio button in the Options tab.

Note: When running on Windows, all users share the same the settings file. On both Mac and 
Linux each user has their own settings file.
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